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The World of SIMmetry
SIMmetry is an advanced 3D modeling platform for GIS-enabled data management, connection, and
communications for improved situational awareness and efficient planning. SIMmetry transports the
user beyond pixels, stats and graphs to an ecosystem that both novice to skilled managers can use to
make more informed decisions, manage assets and safeguard life.
As you navigate and begin to explore the capabilities of SIMmetry, you will notice this software is the
next cutting-edge tool for handling GIS data. This platform makes it possible to integrate existing and
new datasets with multiple coordinate systems, such as topography, land hydrography, engineering
as-built drawings, surface and subsurface utility facilities, and transmitted signal data.
The SIMmetry Quick Start Guide will provide you with a basic understanding of the commonly used
features, tools, and concepts used in this software and enable you to create your own project in no
time. For more information, refer to the User Manual by clicking on Help
corner.

3D model with a flood
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Version 2.0.1.14 | SIMmetry Quick Start Guide

in the upper right-hand

Contents
The World of SIMmetry

ii

1.

Opening, Creating, and Saving Projects

1

1.1

Opening an existing project

1

1.2

Creating a new project

1

1.3

Saving a project as a FLY file

1

2.

Using the Project Tree

2

2.1

Showing and hiding tree elements

2

2.2

Selecting items from the tree

2

2.3

Working with groups

2

2.4

Project Tree Navigation

2

3.

Navigating in the 3D World

3

3.1

Free flight navigation

3

3.2

Using the ribbon controls

3

3.3

Underground navigation

3

3.4

Walk around

4

3.5

Jump to a location

5

3.6

HUD navigation controls

5

4.

Defining the Project

6

4.1

SIMmetry preferences

6

4.2

Project Settings

6

5.

Loading Layers

7

5.1

Layer Types

7

5.2

Loading Feature Layers

7

5.3

Loading Other Layers

8

5.4

Loading Entire Folders

8

6.

Working with Objects

9

6.1

2D Objects

9

6.1.1
6.1.2

9
9

6.2

Creating a shape
Drawing freehand

Labels
6.2.1
6.2.2

9
Creating a text label
Creating an Image label

9
9

7.

Basic Analysis

10

7.1

Measuring Distance Tool

10

7.2

Area Tool

10

8.

Creating Effects

11

Version 2.0.1.14 | SIMmetry Quick Start Guide
Page i of ii

8.1

Environmental Effects

11

8.2

Weather Effects

11

9.

Presentations

12

9.1

Creating and editing presentations

12

9.1.1
9.1.2
9.1.3
9.1.4
9.1.5

12
12
12
12
13

Step 1: Creating a New Presentation
Step 2: Creating a Flight Route
Step 3: Setting up the Terrain
Step 4: Editing the Presentation
Step 5: View the Presentation

Version 2.0.1.14 | SIMmetry Quick Start Guide
Page ii of ii

1.

Opening, Creating, and Saving Projects
SIMmetry .FLY projects are compressed files that contain all project settings and content, and
pointers to terrain databases or other loaded files. Creating a new Project can be initiated
through the File Menu, located at the upper left-hand corner of the software application.

1.1

Opening an existing project
◼

1.2

File Menu > Open

> Browse to an existing .FLY file in your file system.

Creating a new project
1.

From the File menu, select New

2.

Select from the following options:

. The create project dialog box is displayed.

•

Fugro Globe MPT – A medium resolution MPT included in the installation folder.

•

Default Local Terrain – A low resolution MPT with medium resolution covering the
United States region.

•
3.

1.3

Select MPT File – Allows user to select an MPT from workstation file directory.

Click Create Project.

Saving a project as a FLY file
◼

File Menu > Save
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> or Save As

.

2.

Using the Project Tree
The project tree provides quick access to SIMmetry items, enabling you to control the
appearance of information in the 3D Window. Project tree items can be arranged in groups,
according to function, type of information, or location.

2.1

Showing and hiding tree elements
In the Project Tree, click on the group’s show/hide icon

to display or hide all of the group’s

children on the 3D Window. The show/hide feature is also available for
each child in the group. Groups with some children in show mode and
others in hide mode display the following

2.2

icon.

Selecting items from the tree
In the Project Tree, double-click on the required item to perform the items actions that were
defined in the property sheet.

2.3

Working with groups
1.

Create a group by right-clicking on the blank area in the
Project Tree, select Create Group, and enter a name.

2.

To move a group, click on a group and drag to the
desired location.

3.

To move items into a group, click on the item and drag
it to desired group.

4.

Defining group properties can be accessed by rightclicking on a group and selecting Properties. The
property sheet will display.

2.4

Project Tree Navigation
In the Project Tree, double-click on a location or an object.
You can also right-click and select Fly to, Jump to, or View.
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3.

Navigating in the 3D World
SIMmetry provides the user with multiple ways to navigate the 3D World.

3.1

Free flight navigation
Mouse Navigation
Drag mode

Description
The mouse controls the movement of the terrain.
◼

To Pan – click and drag the mouse in desired direction

◼

To Zoom In/Out – roll the middle mouse wheel

◼

To change Direction and Tilt – click and drag the middle mouse
wheel

Slide mode

The mouse controls the movement of the camera.
◼

To Slide – click and drag the mouse in desired direction

◼

To change Direction and Tilt – click and drag the middle
mouse wheel

Turn and tilt mode The mouse controls the movement of the tilt of the camera and direction of the
plane.
◼

To change Direction and Tilt – while pressing the mouse
button, drag the pointer to the outside 3D Window zones

3.2

Using the ribbon controls
Navigation tab > Navigate To group> Select from the following:
◼

Zoom – zooms in or out from the center of the view to a
distance according to the following presents: House, Street,
City, State, Country, Globe

◼

North – turn the place to face north

◼

Rotate – flies in a circle pattern around the terrain
coordinate at the center of the 3D Window

◼

Follow – click and select a navigation pattern. If an object is selected, the user can also
select a predefined view angle

3.3

Underground navigation
The Underground Navigation mode allows the user to explore the subsurface of the terrain.
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◼

3.4

Navigation tab > Navigation Modes group > click

Underground Mode.

Walk around
The walk around navigation controls enable easier navigation within confined spaces, x-ray vision
and collision detection.
1.

Navigation tab > Navigation Modes group > click

2.

If you want to navigate outdoors, click Start.

3.

If you want to navigate indoors, click on the building you want to enter.
Control

Walk Around.

Description
Toggle collision detection on and off. When collision detection is on, any collision
with a solid structure, while navigating within the 3D model, will stop movement.
Toggle x-ray vision on and off. When x-ray vision is on, the model becomes semitransparent, enabling you to see through all model walls.

Adjusts the field of view.

Exit from walk mode
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3.5

Jump to a location

◼

3.6

Navigation tab > Jump To group > enter a set of coordinates and click Jump To.

HUD navigation controls
Access the advanced navigation controls:
1.

Click on the File Menu and the preference dialog box is displayed.

2.

Click the Screen Overlay tab.

3.

In the Show section, Check next to full navigation controls with level indicator.

Navigation Control
Tilt slider
North indicator
Compass ring
Joystick
Zoom slider

Description
Move the tilt slider to change the plane tilt
Click the N indicator in the compass ring to turn the plane to face north
Click and turn the compass ring to change the plane direction
The virtual joystick enables you to free-fly in the 3D World in an intuitive
manner, similar to real-life flying
Click and drag the elevation slider to zoom in and out. You can also click the
globe, country, state, city and street levels
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4.

Defining the Project
Before starting a project, Fugro recommends the user define their working environment. These
settings will be saved for future sessions and saved to the working .FLY file.

4.1

SIMmetry preferences
To access Preferences: File Menu > Preferences
◼

General – manage disc cache size, define KML/KMZ
settings, select raster pyramid formats, and set
default SIMmetry.

◼

Graphics – enables user to select the quality of the
terrain model and add visual effects.

◼

Navigation – settings for navigation the camera in
the 3D Window.

◼

View – define the units used throughout SIMmetry
for elevation, speed, distance and more.

◼

Screen Overlay – graphic and textural display that
projects flight and camera information onto the
terrain view.

◼

Language – set user interface language and define
Unicode.

4.2

Project Settings
To access Project Settings: File Menu > Project Settings
◼

Performance and Quality Setting – generate levels of detail for 3D models is
recommended for projects that have dense model layers, with non-optimized models.

◼

Light Source – Select this option if you want the sun to serve as the light source for the
project. This results in parts of the 3D World being brighter than others based on the tie,
date and time zone set.

◼

Altitude – Type the minimum altitude allowed for the plan in meters or feet above ground
level.
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5.

Loading Layers
SIMmetry offers a convenient way to import various types of layers into a working project using
the Load Layers tab.

5.1

Layer Types
Icon

Layer Type
Feature

A visual representation of a geographic data set like roads, national park,
and rivers

Complex

A combination of different data types in one layer (.FLY and .KML/.KMZ)

3D Mesh

Multi-resolution, textured mesh models that may include classification
layers and polygons from BIM datasets

Point Cloud
Raster

5.2

Description

A series of data points
Layer that is made up of pixels with each one assigned a value

Loading Feature Layers
1.

Load Layers tab > Feature group > Load Layer

2.

Loading layer from file, in the Browse for feature layer dialog box, browse for required file
and click Open.

3.

Loading layer from server, select server
type from the Server type drop down
menu. Click Select and fill in the required
parameters. Click Connect.

4.

In the Select Layer dialog box, select a
layer and click Next.

5.

Define the General Settings of the
imported layer.
a.

To change layer’s coordinate system,
select the Reproject check box. Click
Set Coordinate System to open the
Coordinate Systems dialog box to set
layer’s coordinate system. Click Next.

6.

Click Load.
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5.3

Loading Other Layers
1.

Load Layers tab > Select the required layer type

2.

Loading a layer from file:

3.

4.

5.4

a.

In the dialog box, browse for required file

b.

Click Open

Loading a layer from a server:
a.

Select a server type from the Server type drop down menu

b.

Click Select and fill in the required parameters, click Connect

c.

Select required layer and click Load

After layer is imported, define parameters through the layer’s property sheet.

Loading Entire Folders
1.

Load Layers tab > Load Entire Folder

2.

The browse file directory dialog box is displayed

3.

Select the required folder and click Select Folder

4.

The selected folder will be displayed in the project tree a new group. Contents inside the
selected folder will be converted to layers, reflecting to their corresponding file format.
Note:

When working with TIF and IMG files, load from an entire folder as either imagery
or elevation layers. To load as elevation data, check the required box next to Load
Entire Folder. If left unchecked, these file types will be imported as imagery layers.
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6.

Working with Objects
The ability to create and work with objects can be accessed through the Objects Tab.

6.1

2D Objects
Objects tab > 2D group > 2D Objects > select
desired objects

6.1.1

6.1.2

Creating a shape
1.

In the 3D Window, click and draw an object.

2.

Right-click to finish.

Drawing freehand
1.

In the 3D Window, click and drag the
mouse to draw.

2.

6.2

Release the mouse when finished drawing.

Labels
Objects tab > Label group > Text/Image

6.2.1

Creating a text label
1.

Enter text in the dialog box, click OK.

2.

In the 3D Window, click to place text in
desired location.

6.2.2

Creating an Image label
1.

Browse for an image in dialog box, click
OK.

2.

In the 3D Window, click to place an
image in the desired location.
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7.

Basic Analysis
The Analysis Tab provides the user with quick access to SIMmetry’s tools for conducting analysis
on the terrain.

7.1

Measuring Distance Tool
1.

Analysis tab > Measurement group > Distance. The Measure Distance Tool is displayed.

2.

In the measure distance tool, check the box
next to the required type of measurement.

3.

Measurements can be saved as an object by
checking Create Measurement Objects.

4.

Create start and segment points by clicking
anywhere on the terrain.

5.

7.2

Right-click to finish.

Area Tool
1.

Analysis tab > Measurement group > Area. The Measure Area Tool is displayed.

2.

Click either of the following commands:
•

Horizontal plane area

•

3D plane area

– Calculate area on terrain.

– Calculate area on arbitrary plane.

3.

Measurements can be saved as an object by checking Create Measurement Objects.

4.

Create start and segment points by clicking anywhere on the terrain.

5.

Right-click to finish.
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8.

Creating Effects
The Effects tab provides visual effects that can enhance realism of 3D visualization.

8.1

Environmental Effects
◼

Light Source - The user can toggle the sunlight source on or off. When turned on, the sun,
moon, and sun flare objects are positioned based on the project’s current time, data, and
time zone. The sunlight affects the lighting on terrain and building objects.

◼

Global Shadow - The user can display a shadow effect for an entire scene for more realistic
visualization.

8.2

Weather Effects

Effect
Sky Color
Wind Direction

Procedure
Effects tab > Weather group > Sky Color drop down menu > select a color
Effects tab > Weather group > Wind Direction drop down menu > select a direction

Wind Speed

Effects tab > Weather group > Wind Speed drop down menu > select a speed

Sky Texture

Effects tab > Weather group > Sky Texture > select a texture

Dynamic Clouds

Effects tab > Weather group > Dynamic Clouds > select a cloud cover

Fog

Effects tab > Weather group > select the Fog check box > drag the Fog slider to
adjust the intensity of fog cover

Rain

Effects tab > Weather group > select the Rain check box > drag the Rain slider to
adjust the intensity of rainfall

Snow

Effects tab > Weather group > select the Snow check box > drag the Snow slider to
adjust the intensity of snowfall
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9.

Presentations
SIMmetry’s presentation tools enable the user to create a presentation in which the user can
communicate a specific view of the 3D World.

9.1

Creating and editing presentations

9.1.1

Step 1: Creating a New Presentation
Presentation tab > Create group > New Presentation

9.1.2

Step 2: Creating a Flight Route
Creating a recorded route:
1.

Presentation tab > Locations group >

Record Flight

2.

Navigate in the 3D world to desired points of interest.

3.

Presentation tab > Locations group > Stop Recording

Creating a locations route:
•

Fly to the required location > Presentation tab > Locations group > Add Location

•

Presentation tab > Locations group > Add Location > Select Location

Or

9.1.3

Step 3: Setting up the Terrain
Presentation tab > Operation group > Add Operation >

9.1.4

select an operation

Step 4: Editing the Presentation
1.

Presentation tab > Operations group >

2.

To add captions:
•

3.

Edit Presentation

Right-click step > Add Caption

To reorder steps:
•

Use Move up and Move Down
commands

4.

To delete a step:
•

5.

Select the step and click Delete

Set continue triggers settings for each step:
•

Immediate – next step follows immediately
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•

Click Button – next step follows when Next command on the ribbon is selected

•

Wait – next step follows automatically after waiting the number of seconds set in the
Seconds column

9.1.5

Step 5: View the Presentation

Presentation tab > Play group >
•

Play

Use the toolbar to start, stop, pause, rewind, and fast forward
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